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 What’s New for
Avid® Media Composer® v8.4

Revision History

New Features

The following table describes What’s New for the current editor release.

Date Description

July 13, 2015 Updated “Additionally Supported Formats for Capture” on page 9.

Feature Description For More Info

Custom Projects You can set a custom frame size for your 
project.

See “Custom Projects” on page 3.

XAVC-I Native Support The editing application includes native 
support for Sony XAVC-I format.

See “XAVC-I Support” on page 4.

Apple® ProRes Native 
Support

Media Composer now includes native support 
for Apple ProRes 2K/4K/UHD media

See “Apple ProRes Support” on 
page 4.

Remove Color Adapters 
from a Sequence

You can now remove color adapters from a 
sequence before you send it for color 
correction on another system.

See “Remove Color Adapters 
from Sequence” on page 7.

Reformatting Media You can now manage your default setting for 
linked media.

See “Reformatting Media” on 
page 21.

Viewer Mask Options An option for Mix to Black has been added to 
the Target Mask submenu in the Source and 
Record viewers.

See “Viewing Sequences with 
Mask Regions” in the Help.

Previewing Closed 
Captioning

The editing application supports previewing 
Closed Captioning in the monitors and 
Timeline.

See “Previewing Closed 
Captioning” on page 4.

Timeline Quick Find You can quickly search for text in the 
Timeline.

See “Searching for Text in the 
Timeline” on page 8.
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Lists Tool Improvements A number of improvements have been made 
to the Lists Tool.

See “List Tool Improvements” on 
page 13.

Background Render, 
Background Transcode and 
Dynamic Media Folders 
supported with Media 
Composer | Cloud

 Dynamic Media Folders, Background render 
and Background transcode are compatible 
with Media Composer | Cloud systems.

See “Dynamic Media Folders and 
Background Render Support with 
Media Composer | Cloud” on 
page 15.

Composer Monitor Change You can resize a single monitor to a larger 
size than in previous releases.

See “Composer Window Sizing 
Changes” on page 9.

Terminology Changes AMA is now referenced as Link in the editing 
application.

All import and export settings for scaling of 
color levels from full range (RGB) to legal 
range (video) have been updated with more 
intuitive terminology.

See “Terminology Changes” on 
page 10.

See “Mapping of Color Levels” 
on page 10.

Adapter Display in 
Timeline

The source side adapters icons are now 
represented individually so that you can 
quickly see which adapter has been applied to 
the clip. The display of these icons can be 
turned on/off individually.

See “Adapters Displayed in 
Timeline” on page 12.

Refresh Sequence All The More tab of the Command Palette now 
has a Refresh Sequence ALL button that can 
be added to your Timeline toolbar and 
mapped to your keyboard.

See “Refreshing Sequences to Use 
Current Clip Attributes” in the 
Help.

AAX Factory Presets The editing application supports Pro Tools 
presets for audio track effects.

See “Support for Pro Tools 
Presets” on page 16.

Alpha support for 
QuickTime wrapped 
DNxHR

This release includes Alpha support for 
QuickTime-wrapped DNxHR media.

See “Alpha Support for 
QuickTime-Wrapped DNxHR” on 
page 16.

Inactive Audio Tracks You can choose to include inactive audio 
tracks in the export process.

See “Export Including Inactive 
Audio Tracks” on page 17.

Transcoding Media In previous releases, you could transcode 
with the media’s original frame rate only 
when working with greater than HD projects. 
With this release, it now also applies to SD 
and HD projects.

See “Transcoding Media 
Updates” on page 17.

Feature Description For More Info
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Custom Projects

There is a new Custom option in the drop-down Format menu of the New Project dialog that 
allows you to set a custom frame size for your project. You must enter even values in the Raster 
Dimension boxes (height x width). The minimum size is 256 pixels in width by 120 pixels in height, 
and the maximum size is 8192 by 8192 pixels. The minimum dimensions are maintained even when using 
1/4 and 1/16 proxy mode.

For stereoscopic projects, the height must be divisible by 4 and the width divisible by 8. For 
example: 1600 x 6000.

You can also save all your custom raster dimensions by clicking the Save Preset button. Enter a 
name for your preset and click OK. The next time that you open a new project, this preset will be 
available under the Format drop-down menu as My Presets. Currently, these Presets cannot be 
deleted. 

Deleting AMA metadata 
files associated with linked 
master clips.

You can now delete metadata files associated 
with linked master clips.

See “Deleting Metadata Files 
Associated with Linked Media” 
on page 21.

Four Channel Audio 
Monitoring options

Additional options have been added to the 
Audio Mixer tool that tell the editing 
application the number and position of 
speakers connected to your workstation. The 
output of the sequence set in the Sequence 
Mix Mode is mixed into the speakers 
available according to one of these modes.

See “Four Channel Audio 
Monitoring” on page 22.

Feature Description For More Info
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n All the current frame rates are supported for custom projects (23.98fps to 60fps). Also, custom 
projects will use DNxHR for media creation and render settings.

XAVC-I Support

Media Composer now includes native support for the Sony XAVC-I format using the latest Sony 
AMA plug-in. Link to XAVC-I UHD or 4K media and playback the clips in realtime. 

Apple ProRes Support

Media Composer now includes native support for Apple ProRes 2K/4K/UHD media. Link to 
Apple ProRes media and playback the clips in realtime.

Previewing Closed Captioning

You can now preview Closed Captions in the Record monitor, Source monitor, pop-up monitors, 
and in the Timeline D-Track. With this release, EIA-608 compatibility bytes in EIA-708 Closed 
Caption data from the 436M ANC stream of the D-Track is supported. Pop-on, Roll-up and 
Paint-on captions are supported.

To preview Closed Captions:

1. Load the clip or sequence.

2. Right-click the monitor where you want to preview the Closed Captions.
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3. Select Show Captions.

The captions appear in the monitor.

The Closed Captions appear in the D-Track of the Timeline.

Example of Pop-On Closed Captions in D-track

The D-track provides visual information on when the caption is loading, displaying and 
switching to the next caption.
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From left to right: Caption loading, Caption playing, Next caption loading

The caption loading phase (black solid line) contains information to properly display the 
caption. The caption playing phase (gray line) contains mostly filler. If you are editing the 
D-track, it is safe to edit in the gray area. Note that Roll-on and Paint-on captions do not 
display the same as Pop-On captions in the Timeline 

Example of Roll-on caption in Timeline

n It is safe to insert filler in the D-track.

n If you make edits to the data track, you should check your work with a decoder because what 
appears on the desktop video does not take the edits into account.

If you edit in the solid black area of the D-track, you could break the caption. If you do make 
an edit through a caption, an orange triangle icon appears in the Timeline to indicate the 
caption could be broken.
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Searching for Closed Captions Text in the Timeline

You can use the Timeline Quick Find text box to search for Closed Caption text.

To search for Closed Caption Text in the Timeline:

1. Load the sequence containing the Closed Caption data track.

2. Follow the procedures in “Searching for Text in the Timeline” on page 8. Make sure that 
Visible Timeline Text is selected in the search criteria.

Exporting Closed Captions Text

You can export the Closed Caption text as either TTML (Timed Text Markup Language), or SCC 
(Scenarist Closed Caption) format.

To export Closed Caption Text 

1. Select the sequence containing the Closed Caption text.

2. Select File > Export.

3. Click Options.

The Export Settings dialog opens.

4. Select TTML or SCC from the Export As pulldown menu.

5. Select the location for the .ttml or .scc file.

Remove Color Adapters from Sequence

You can remove color adapters from a sequence before you send it for color correction on 
another system. Duplicate your sequence so that you save a version with the color adapters. Then 
select, Refresh Sequence > Remove Color Adapters.

 Color adapters are removed at the sequence level so that you can export the sequence as an AAF 
for color correction on another system. This function does not affect adapters on the master clips 
(as source settings); only the sequence is modified.

If you want to transcode clips associated with the sequence without their color adapters, then you 
need to deselect the “Apply source transformations > Color encoding” option in the Transcode 
dialog.
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Searching for Text in the Timeline

The Timeline Quick Find field allows you to enter text that you can search for in the sequence in 
the Timeline. 

To search for text in the Timeline:

1. Load the sequence in the Timeline.

2. Click the Timeline Quick Find field.

Timeline Quick Find field, Find to the left button, Find to the right button

3. Enter the text you want to search for in the text field. 

4. To customize the search, use the text field drop down menu and select which text options 
you want to search. You can search for Visible Timeline Text, Resolution, Clip Name, 
Comments, Markers, All, or any combination of these search options.

5. Click the Find to the right or Find to the left button. 

The Timeline blue bar moves to the start of the next Timeline segment whose metadata 
contains a match for the search string, based on the search menu's filter options. 

6. If necessary, click the Find left or right buttons to continue searching for the text in the 
Timeline sequence.
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Additionally Supported Formats for Capture

With this release, the following additional formats are supported for capture.

Composer Window Sizing Changes

When the Composer window is displayed as a single monitor, it is now possible to resize the 
monitor to a much larger size. A menu option has been added to the Special menu that allows 
you to easily switch between single and dual monitor. 

Dragging the Source/Record monitor no longer snaps between dual and single monitors.

To resize a Single Monitor:

1. Select Special > Show Single/Dual Monitor or right-click in the Composer monitor and 
select Show Single/Dual Monitor to display a single monitor.

The Source/Record monitor changes to a single Record monitor.

2. Drag the lower right corner of the monitor to the desired size.

3. (Optional) You can map the Show Single/Dual Monitor menu command to your keyboard to 
easily switch between dual and single monitors. See “Mapping Menu Commands” in the 
Help.

Project Format Frame Size Frames/Sec

1080p 1920 x 1080 50p, 59.94p, 60p

2K 2048 x 1152 23.976p, 24p, 25p

2K Full Aperture 2048 x 1556 23.976p, 24p, 25p

Ultra HD 3840 x 2160 23.976p, 24p, 25p, 29.97p, 30p, 
50p, 59.94p, 60p

4K DCI Full 4096 x 2160 23.976p, 24p, 25p, 29.97p, 30p, 
50p, 59.94p, 60p
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Terminology Changes

In an effort to simplify terminology in the editing application, references for AMA are now 
referred to as Link. This will be most notable when you are looking for the AMA Settings in the 
Project Settings window. AMA settings now appear in the Link settings option.

Mapping of Color Levels

All import and export settings for scaling color levels from full range (RGB) to legal range 
(video) have been updated with more intuitive and consistent terminology. In the Import and 
Export Settings, the sections are titled Color Levels.
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In all areas, the reference to RGB and 601/709, has been refreshed with more task-directed 
options for scaling of full range and legal range.

Adapters Displayed in Timeline

Clips that have source-side color, spatial and motion adapters, now have these effects indicated 
by separate icons instead of the green dot. 
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Temporal (motion) adapters appear with a T, spatial (FrameFlex) adapters appear with an S, and 
Color adapters appear with a C. If there is a render dot on the clip it will appear on the effect 
icon. If there is no effect icon, the render dot will appear on the adapters.

You can change your timeline display to selectively turn the icon display on or off. Select the 
Timeline fast menu (hamburger menu) and choose which adapters you want to appear in the 
Timeline.

List Tool Improvements

This release incorporates the following improvements for the Lists Tool. 

• Added handles to EDL events

• Easy access to the Preview Pane tools

• Timeline blue bar interaction with EDL events

• Background color to the Preview Pane when in Edit Mode

• Print List

• Clear List

Adding Handles to an EDL 

You can now add handles to an EDL. You can load a sequence into the List Tool and add handles 
to the start and end of the sources. This saves time from manually trimming each source in the 
new Timeline. See the List Tool List Options.
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Preview Window Tool Bar

Easy access tools appear above the Preview Pane. This gives you quick access to enabling 
Timeline tool bar interaction with EDL events, setting the Font size, accessing Edit Mode, and 
accessing the Find and Replace text fields.

Timeline bluebar interaction button, Set Font Size button, Edit Mode button, Show Find Tools button

Timeline Blue Bar Interaction with EDL Events

When you generate an EDL from a sequence loaded in the Timeline, you can click the Timeline 
Blue Bar Interaction button. Then when you select an event in the EDL list, the blue bar in the 
Timeline will move to that event in the sequence. And when you select the blue bar in the 
Timeline, the applicable event in the EDL list is highlighted.
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Set Font Size Button

Click the Set font size button to change the font size of the EDL, Cut List, or Change list text in 
the Preview pane.

Background Color for Edit Mode

Click the Edit Mode button to enter edit mode. Once you click the Edit Mode button, the 
background of the Preview pane changes to purple. This helps you easily see that you are in Edit 
Mode. To exit Edit Mode, simply click the Edit Mode button again.

Show Find Tools Button

When in Edit Mode, click the Show Find Tools button to open the Find and Replace text fields at 
the bottom of the Preview pane. 

n In previous releases, searching was available for EDLs. Searching is now available for Change 
Lists and Cut Lists.

Print List

You can print the list that appears in the Preview pane. Click Print List from the File menu.

Clear List

You can Clear the list that appears in the Preview pane. Click the Clear List button at the top of 
the Preview pane.

Dynamic Media Folders and Background Render Support with 
Media Composer | Cloud 

In previous releases, separate transcode services were installed with the editing application and 
Media Composer | Cloud. These transcode services were not compatible, therefore you could not 
use Dynamic Media Folders, background render, and background transcode with Media 
Composer | Cloud. With this release, the transcode services have been merged and Dynamic 
Media Folders, background render and background transcode work with Media Composer | 
Cloud. For details on using Media Composer | Cloud, see “Using Your Avid Editing Application 
with Media Composer | Cloud” in the Help.

n You cannot stop and start the services if you are logging into Media Composer | Cloud. 
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Support for Pro Tools Presets

You now have the same AAX factory-provided presets used in ProTools. When you access an 
Audio Track Effect, you can choose the factory default Plug-in settings as shown below.

You can also select a preset setting, make adjustments and select Save Setting As to save the 
adjusted setting. The saved setting appears as a selectable preset when you choose that plug-in.

Alpha Support for QuickTime-Wrapped DNxHR

The alpha channel is now supported with DNxHR media. Using third-party applications, such as 
AfterEffects, you can now create QuickTime wrapped DNxHR movies that contain an alpha 
channel. The DNxHR QuickTime components must first be installed on these systems.

To export your media from a third-party system and import into Media Composer:

Create the necessary effects and export your file as DNxHR 444 that includes Alpha. 

Fast Import or link those QuickTime files into Media Composer. 
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Note - You cannot export sequences with alpha from Media Composer. Only Titles and Matte 
Keys can be exported. 

Export Including Inactive Audio Tracks

The Export Settings dialog now displays the option to include inactive audio tracks. When this 
option is selected, inactive audio tracks will be included with the exported sequence. This option 
is on by default. 

Note also the terminology for Use Enabled Tracks has changed to Use Selected Tracks.

Transcoding Media Updates

A few options have been added to the Transcode dialog. 

• Keep source’s frame rate

• Convert to project frame rate

• Apply source transformations
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Transcoding Media at Original FPS

In the previous release, you could transcode with the media’s original frame rate only when 
working with greater than HD projects. With this release, it now also applies to SD and HD 
projects.

When “Keep Source's Frame Rate” is selected, the list of available codecs changes to the 
DNxHR family. If you need to use older codecs in HD/SD, select “Convert to project frame 
rate.” See “Transcode Options” on page 19.

Applying Source Transformations when Transcoding

When you select a sequence for transcoding, any source transformation adjustments done on the 
Timeline are not applied. The transcode operation only applies source transformations that were 
made on the clip (from the bin). This keeps your proxy media intact. 

If you have applied further transformation adjustments on the Timeline, these are processed on 
the fly, so you might see a slowdown in performance when playing your sequence. 

If you want to get real-time playback when previewing your sequence, you can choose to apply 
the source transformations when transcoding. However, when you are doing the final render for 
output, make sure that you link back to the source clips.
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See “Transcode Options” on page 19. 

Transcode Options

See the following description of the options in the Transcode dialog.

Option Description

Video and audio on 
same drive(s)

Select to store the transcoded media files on the same target drive. 
Deselecting this option lets you select separate drives for the audio 
and video media files.

Handle length n frames If you are transcoding subclips or sequences, type a handle length for 
the new clips, or accept the default: leave it at 60 frames (NTSC) or 
50 frames (PAL). The handle length is the number of frames outside 
the IN and OUT points that you can use for dissolves and trims with 
the new, shorter master clips.

Create new 
sequence(s)

Select this option to create a new sequence from the transcoded clips.

Transcode only linked 
media

Select this option if you want only linked media transcoded.

Create new clips In an Interplay environment, with Dynamic Relink enabled, select 
this option to create new master clips for the transcoded media. If you 
do not select this option, the existing master clip is associated with 
both the original media file and the transcoded media file. For more 
information, see “Understanding How Clips are Associated with 
Multiple Resolutions” on page 54.

Convert Video Select this option to convert the video to the target video resolution.

Raster Dimensions This option allows you to select the transcode raster dimensions. 
Project dimensions (proxy off) - Transcodes the clip at the resolution 
set for the project.
Source dimension - Transcodes the clip at its original resolution. 
Source 1/4 - Transcodes the clip at a quarter of its original resolution. 
Source 1/16 - Transcodes the clip at 1/16 of its original resolution.

n When transcoding multiple clips at source dimensions, each 
clip will be transcoded at its original size or relative 1/4, 1/16 
selected setting.

n The minimum dimensions are 256 pixels in width by 120 pixels 
in height. So for example, in a 960x540 project, only 1/4-proxy 
(480x270) will be available and not 1/16-proxy (240x135).
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Keep Source’s Frame 
Rate

When this option is selected, the list of available codecs changes to 
the DNxHR family. 

Convert to Project 
Frame Rate

Converts the media to the project’s frame rate. Select this option if 
you need to use older codecs in HD or SD.

Target Video 
Resolution

Select a video resolution for the sequence.

Linked Source 
Scaling/Quality

Sets the playback quality for linked media. You can choose Full, Half 
(Best Quality), Half (Good Quality), Quarter, Eighth, Sixteenth. The 
default setting is Full.

Apply source 
transformations

Color encoding - Select this option if you want to transcode clips with 
their applied color adapters.
Frame Flex - Select this option if you want to transcode clips with 
FrameFlex formatting.

n If you intend to send your sequence for effects or finishing on a 
third-party system, Avid recommends that you use the original 
source dimensions and frame rate, and not apply source 
transformations when transcoding.

n If you do not select these options, the adapters are bypassed 
during the sequence transcode only. The source 
transformations still remain on the clips in the bin

Convert Audio Sample 
Rate

Select this option to convert any sample rates not set in the Sample 
Rate menu in the Main tab in the Audio Project Settings window. For 
information on setting the sample rate, see “Changing the Audio 
Sample Rate for Sequences and Audio Clips” on page 944.

Target Audio 
Sample Rate

Select a sample rate for the sequence.

Convert Audio Bit 
Depth Conversion

Select this option to convert the audio to the target bit depth.

Target Audio Bit 
Depth

Select either 16 bit or 24 bit.

Convert Audio Format Select this option to convert the audio to the target audio format.

Target Audio 
Format

Select either OMF (WAVE), OMF (AIFF-C), or MXF (PCM) audio 
format. See “Audio Projects Settings: Main Tab” on page 48.

Run in Background Select this option to have the transcode operation run in the 
background.

Option Description (Continued)
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Reformatting Media

You can now manage your default setting for linked media (choices are Letterbox/Pillarbox, 
Center Crop, Center Keep Size or Stretch).

This setting is available from Settings > Link > Link Options. There is a Reformatting option at 
the bottom of the dialog that lets you set the default for new clips.

There is also an option to set SD clips as 16:9 by default. This setting forces all this SD media to 
be tagged as 16:9.

Deleting Metadata Files Associated with Linked Media

You now have the option to delete the metadata files associated with linked media. 

To delete the metadata associated with linked media:

1. Select Tools > Media Tool.

2. Choose the drive and project that contain the linked media. Make sure Linked Master Clips 
is selected.

3. Click OK.
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The Media Tool opens.

4. Select the files whose metadata you want to delete.

5. Press the Delete key.

6. In the Delete dialog box, select the AMA Delete metadata files(s) option.

7. Click OK. 

The associated metadata files are deleted. Selecting this option does not delete the media 
files. Only associated metadata files are deleted. 

Four Channel Audio Monitoring

The monitoring options in the Audio Mixer Tool and the Output tab of the Audio Project Settings 
have been updated to provide new Four Channel Audio monitoring options.

• Stereo: Stereo sequences are output in stereo as expected. Surround sequences are folded 
down to stereo, rear and side channels are mixed at -3dB into the corresponding front left 
and right, center and LFE channels are panned to center.   If you have four or more physical 
outputs, you can choose the output channel pair in Audio Project Settings.

• Mono: Pans all the currently monitored tracks to center and ignores pan effects.

• 4-channel LRCLfe - The four channels are Left, Right, Center, and Lfe (Low Frequency 
Effects) in that order. L, R, C, and Lfe are sent directly to their corresponding channels. Rear 
and side channels are mixed at -3dB into front left and right. Four-channel modes cannot be 
reassigned. Even if you have eight outputs, the four channel modes are always the first four.

• 4-channel LRCS - The four channels are Lef,t, Right, Center, and Surround, which is a 
single rear loudspeaker L, R, and C are sent directly to their corresponding channels. Lfe is 
mixed at -3dB into front left and right Rear channels panned into the single rear center. Side 
channels (side centers in a 7.1 mix) are panned between the single rear channel and the 
corresponding front channel. 

• 4-channel Quadraphonic - The four channels are in four corners of the listening space, L, 
R, Ls Rs. Left, Right, Left Rear, and Right Rear are sent directly to their corresponding 
channels. Center, Left Center, and Right Center are panned to the centers of their 
corresponding speaker pairs. Lfe is mixed at -3dB into front left and right. 
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• 6-channel 5.1 Pro Tools, (L C R Ls Rs Lfe), and 5.1 SMPTE (L R C Lfe Lr Rr) “Film” 
channel order has been renamed “Pro Tools” channel order, consistent with contemporary 
usage and with the naming of the 7.1 channel orders. Stereo sequences are output only to L 
and R, in the selected channel order. Surround 5.1 sequences have channels re-ordered to 
match the selected channel order. Surround 7.1 sequences, have their center side channels 
are panned to the center of their corresponding speaker pairs. If you have more than eight or 
more audio outputs, you can choose to start the 5.1 mix at position 1 or position 3 of any 
8-channel group..

• 8-channel 7.1 Pro Tools, (L C R Lss Rss Lsr Rsr Lfe), and 7.1 SMPTE (L R C Lfe Lsr Rsr 
Lss Rss) Note Lsr and Rsr and left and right “surround rear”, Lss and Rss are left and right 
“surround side”. Stereo sequences are output only to L and R, in the selected channel order. 
Surround 5.1 and 7.1 sequences have channels re-ordered to match the selected channel 
order. Lss and Rss remain silent when playing 5.1 sequences. If you have 16 outputs, you 
can choose to start the 7.1 mix at position 1 or position 8. 

• Direct out, Panning and master fader effects are ignored. Each track is mixed into one or 
more outputs according to the output assignments in the Audio Project Settings output pane. 
Stereo and surround tracks will be sent to multiple adjacent outputs, and the channels within 
surround tracks are re-ordered according to SMPTE or Pro Tools channel order conventions 
as selected.
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Avid Media Composer may reproduce this publication for 
the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, 
for commercial purposes, such as selling copies of this document or providing support or educational services to others. This 
document is supplied as a guide for Avid Media Composer. Reasonable care has been taken in preparing the information it contains. 
However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not 
accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

Copyright © 2014 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.
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The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid Remote 
Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Axiom, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, Conectiv, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, Dazzle Digital Video Creator, D-Command, D-Control, Deko, 
DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, 
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, 
DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, 
DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, 
Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame 
Chase, FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE 
HDCAM, iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording 
Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, 
KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, Luna, MachineControl, Magic Mask, 
Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, M-Audio, M-Audio Micro, 
Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, Media Reader, Media Recorder, MEDIArray, 
MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, Mix Rack, MixLab, Moviebox, Moviestar, 
MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF 
Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, 
Personal Q, PET, Podcast Factory, PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro 
Transfer, Pro Tools, QuickPunch, QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape 
Saturation, Reprise, Res Rocket Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, 
Scorch, Scorefitter, ScriptSync, SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, 
SIDON, SimulPlay, SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, 
SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, 
Studiophile, SubCap, Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, SYNC I/O, 
Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL 
Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, Torq Xponent, Transfuser, Transit, 
TransJammer, Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Video the Web Way, VideoRAID, 
VideoSPACE, VideoSpin, VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either 
registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows 
is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other 
trademarks contained herein are the property of their respective owners. 

http://www.apache.org/
http://jcifs.samba.org/
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Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.
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